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Preface
About This Manual

The manual describes how to install Rational ClearCase on the Windows platform. 
Read this manual to understand the basics of installing ClearCase; then refer to the 
Administrator’s Guide for Rational ClearCase for information about configuring and 
maintaining your environment.

This manual is intended for use by a system administrator, who is setting up ClearCase 
in a production environment.

For a complete list of ClearCase integrations, refer to the Rational Web site at 
www.rational.com.
v
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ClearCase Integrations with Other Rational Products

Integration Description Where it is documented

Base ClearCase- 
ClearQuest

Associates change requests 
with versions of ClearCase 
elements.

ClearCase: Developing Software 
ClearCase: Managing Software 
Projects 

ClearQuest: Administrator’s Guide

Base ClearCase-Apex Allows Apex developers to 
store files in ClearCase.

Installing Rational Apex (UNIX)

Base ClearCase- 
ClearDDTS

Associates change requests 
with versions of ClearCase 
elements.

ClearCase ClearDDTS Integration 

Base ClearCase-
PurifyPlus

Allows developers to invoke 
ClearCase from PurifyPlus.

PurifyPlus Help

Base ClearCase- 
RequisitePro

Archives RequisitePro projects 
in ClearCase.

RequisitePro User’s Guide 

RequisitePro Help

Base ClearCase-Rose Stores Rose models in 
ClearCase.

Rose Help

Base ClearCase- 
Rose RealTime

Stores Rose RealTime models in 
ClearCase.

Rose RealTime Toolset Guide 

Rose RealTime Guide to Team 
Development

Base ClearCase-SoDA Collects information from 
ClearCase and presents it in 
various report formats.

Using Rational SoDA for Word 
Using Rational SoDA for Frame 

SoDA Help

Base ClearCase-XDE Stores XDE models in 
ClearCase

XDE Help

UCM-ClearQuest Links UCM activities to 
ClearQuest records.

ClearCase: Developing Software 

ClearCase: Managing Software 
Projects

ClearQuest: Administrator’s Guide

UCM-PurifyPlus Allows developers to invoke 
ClearCase from PurifyPlus.

PurifyPlus Help
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Typographical Conventions

This manual uses the following typographical conventions:

■ ccase-home-dir represents the directory into which the ClearCase Product Family 
has been installed. By default, this directory is /opt/rational/clearcase on UNIX and 
C:\Program Files\Rational\ClearCase on Windows. 

■ cquest-home-dir represents the directory into which Rational ClearQuest has been 
installed. By default, this directory is /opt/rational/clearquest on UNIX and 
C:\Program Files\Rational\ClearQuest on Windows. 

■ Bold is used for names the user can enter; for example, command names and 
branch names.

■ A sans-serif font is used for file names, directory names, and file extensions.

UCM-RequisitePro Allows RequisitePro 
administrators to create 
baselines of RequisitePro 
projects in UCM, and to create 
RequisitePro projects from 
baselines.

RequisitePro User’s Guide 
RequisitePro Help

Using UCM with Rational Suite

UCM-Rose Stores Rose models in 
ClearCase.

Rose Help

Using UCM with Rational Suite 

UCM-Rose RealTime Associates activities with 
revisions.

Rose RealTime Toolset Guide 

Rose RealTime Guide to Team 
Development

UCM-SoDA Collects information from 
ClearCase and presents it in 
various report formats.

Using Rational SoDA for Word 
Using Rational SoDA for Frame 

SoDA Help

UCM-TestManager Stores test assets in ClearCase. Rational TestManager User’s Guide 

TestManager Help
Using UCM with Rational Suite 

UCM-XDE Stores XDE models in 
ClearCase

XDE Help

UCM-XDE Tester Stores XDE Tester Datastores in 
ClearCase

XDE Tester Help

Integration Description Where it is documented
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■ A sans-serif bold font is used for GUI elements; for example, menu names and 
names of check boxes.

■ Italic is used for variables, document titles, glossary terms, and emphasis. 

■ A monospaced font is used for examples. Where user input needs to be 
distinguished from program output, bold is used for user input.

■ Nonprinting characters appear as follows: <EOF>, <NL>. 

■ Key names and key combinations are capitalized and appear as follows: SHIFT, 
CTRL+G.

■ [ ] Brackets enclose optional items in format and syntax descriptions.

■ { } Braces enclose a list from which you must choose an item in format and syntax 
descriptions.

■ | A vertical bar separates items in a list of choices.

■ ... In a syntax description, an ellipsis indicates you can repeat the preceding item 
or line one or more times. Otherwise, it can indicate omitted information.

Note: In certain contexts, you can use “...” within a pathname as a wildcard, similar 
to “*” or “?”. For more information, see the wildcards_ccase reference page.

■ If a command or option name has a short form, a “medial dot” ( ⋅ ) character 
indicates the shortest legal abbreviation. For example:

lsc⋅heckout 

Online Documentation 

The ClearCase Product Family (CPF) includes online documentation, as follows:

Help System: Use the Help menu, the Help button, or the F1 key. To display the contents 
of the online documentation set, do one of the following:

■ On UNIX, type cleartool man contents 

■ On Windows, click Start > Programs > Rational Software > Rational ClearCase > 
Help 

■ On either platform, to display contents for Rational ClearCase MultiSite, type 
multitool man contents 

■ Use the Help button in a dialog box to display information about that dialog box or 
press F1.
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Reference Pages: Use the cleartool man and multitool man commands. For more 
information, see the man reference page. 

Command Syntax: Use the –help command option or the cleartool help command.

Tutorial: Provides a step-by-step tour of important features of the product. To start the 
tutorial, do one of the following:

■ On UNIX, type cleartool man tutorial 

■ On Windows, click Start > Programs > Rational Software > Rational ClearCase > 
ClearCase Tutorial 

PDF Manuals: Navigate to:

■ On UNIX, ccase-home-dir/doc/books 

■ On Windows, ccase-home-dir\doc\books 

Customer Support

If you have any problems with the software or documentation, please contact Rational 
Customer Support by telephone, fax, or electronic mail as described below. For 
information regarding support hours, languages spoken, or other support information, 
click the Support link on the Rational Web site at www.rational.com.

Your 
location

Telephone Facsimile Electronic mail

North 
America

800-433-5444
toll free or 
408-863-4000
Cupertino, CA

408-863-4194
Cupertino, CA
781-676-2460
Lexington, MA

support@rational.com 

Europe, 
Middle 
East, and 
Africa

+31-(0)20-4546-200
Netherlands

+31-(0)20-4546-201 
Netherlands

support@europe.rational.com 

Asia Pacific 61-2-9419-0111
Australia

61-2-9419-0123
Australia

support@apac.rational.com 
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1Installation Overview
Rational ClearCase is a comprehensive software configuration management system 
that manages multiple variants of evolving software systems and tracks changes. 

ClearCase maintains a complete version history of all software development artifacts, 
including code, requirements, models, scripts, test assets, and directory structures. It 
performs audited system builds, enforces site-specific development policies, offers 
multiple developer workspaces, and provides advanced support for parallel 
development. ClearCase includes Unified Change Management (UCM), an optional, 
out-of-the-box process for organizing software development teams and their work 
products.

Choosing an Installation Option

This manual describes the following installation options:

■ Enterprise deployment. This is the standard installation option. It allows you to 
install ClearCase with a set of customized site defaults.

■ Desktop installation from CD image. Choose this type of installation when you 
are installing ClearCase on a single computer, usually for evaluation purposes. 
This option is not recommended for production use.

The Installation Road Map on page 2 presents the sequence of the installation. Use the 
task checklists in this manual to ensure that you complete each step of the installation.

Upgrading from ClearCase LT

Rational ClearCase LT can be easily upgraded to Rational ClearCase. ClearCase 
includes a tool that helps you automate the upgrade process, though a few manual 
steps may be required to upgrade certain configurations. The upgrade preserves all of 
your VOB data. For more information, see Appendix D, Upgrading from ClearCase LT.

Additional Functionality

ClearCase supports a number of powerful features not available in ClearCase LT:
1



■ Ability for a client to access multiple servers
■ Dynamic views, using the ClearCase multiversion file system (MVFS)
■ ClearCase build auditing tools
■ An expanded ClearCase registry that supports registry regions 
■ Compatibility with MultiSite, which you can purchase to provide support for 

geographically dispersed development teams

For more information about these and other ClearCase features, see the Introduction to 
Rational ClearCase and Managing Software Projects. 

Installation Road Map

1 Read the Release Notes.

2 Read Chapter 1, Installation Overview, to get an overview of the installation options 
available.

3 Read Chapter 2, Before You Install ClearCase, to verify that your installation 
environment meets all requirements.

4 Select the option you want to use.

❑ The Enterprise deployment option allows you to create a release area. A release 
area is a central location on your network, accessible by all hosts, that contains 
site defaults used in the installation process. You create a release area by 
choosing from a number of site default parameters. After the release area is set 
up, any number of clients and servers can be installed from this release area. For 
more information, see Chapter 3, Creating a Release Area and Chapter 4, Installing 
from a Release Area.

❑ The Desktop installation from CD image option installs both server or client 
directly from the CD, rather than creating a release area. If you do not create a 
release area, it is difficult to maintain your ClearCase installation. Therefore, we 
do not recommend installing from the CD, except when you are installing 
ClearCase on a single computer, as in an evaluation.

See Table 1 for a summary of the recommended reading path.
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If You Are New to ClearCase

If you have not used ClearCase before, the Introduction explains some basic terms and 
concepts. It is not necessary to read that book before installing the product, but it is 
helpful to become acquainted with the basics of VOBs and views.

Table 1 Recommended Reading Path for ClearCase Installation Documentation

Scenario Reading path

If you are a new ClearCase user or are upgrading 
from an existing version of ClearCase, use the 
Enterprise deployment option.

Chapter 1, Installation Overview

Chapter 2, Before You Install 
ClearCase

Chapter 3, Creating a Release Area

Chapter 4, Installing from a Release 
Area

If you are upgrading from ClearCase LT to 
ClearCase, use the Enterprise deployment option. 
However, you must first upgrade your 
ClearCase LT installation to ClearCase. 

Follow the procedure in Appendix D. Reference 
Chapter 3 and Chapter 4 as directed.

Chapter 1, Installation Overview

Chapter 2, Before You Install 
ClearCase

Appendix D, Upgrading from 
ClearCase LT

If you want to evaluate the product on a local 
computer, use the Desktop install from CD image 
option.

Chapter 1, Installation Overview

Chapter 2, Before You Install 
ClearCase

Appendix A, Evaluating ClearCase 
On a Local Computer

If you want to use the silent install feature to 
install ClearCase on other computers from a 
networkwide release area, use the Silent Install 
feature.

Appendix B, Using Silent Install

If you want to download and apply a service 
release, use the Rational Download Manager.

Chapter 5, Applying Service 
Releases
Chapter 1 - Installation Overview 3
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2Before You Install 
ClearCase
It is critical that you review the information in this chapter to prepare your 
environment for installation of Rational ClearCase.

Preinstallation Checklist

Table 2 lists all recommended prerequisites and includes cross-references for 
additional information about installing ClearCase.

Table 2 Preinstallation Checklist

Done Task Reference

Review release notes. Reviewing the Release Notes on page 7

Ensure that your installation meets 
all system requirements.

System Requirements on page 7

Learn about the different host types 
that are used by ClearCase.

ClearCase Host Types on page 11

Designate which hosts assume each 
logical host type.

Designating Server and Client Hosts on 
page 13

Ensure that you select the 
appropriate VOB database schema 
version.

VOB Database Schema Versions on 
page 13

If you are running different versions 
of ClearCase on multiple ClearCase 
hosts, ensure compatibility of clients 
and servers among the various 
versions.

Ensuring Feature Compatibility Across 
Versions of ClearCase on page 14

If you plan to install ClearCase 
MultiSite, ensure that your 
environment is compatible.

Planning for MultiSite Installation on 
page 15
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If you plan to install Rational 
ClearQuest, ensure that your 
environment is compatible.

Ensuring ClearQuest Compatibility with 
ClearCase on page 18

Plan for ClearCase installations on a 
dual-boot computer.

Planning for ClearCase Installations on 
Dual-Boot Computers on page 18

Decide whether to enable Remote 
Administration.

Enabling Remote Administration on 
page 18

Ensure that your system supports 
compatible character encoding 
schemes across ClearCase clients.

Ensuring Compatible 
Character-Encoding Systems on 
page 19

Decide how many ClearCase and 
MultiSite licenses you need and how 
to allocate these licenses on your 
network.

Allocating Licenses on page 19

Determine whether you need to 
perform any tasks dependent on 
your unique environment.

Environment-Specific Tasks on page 21

Learn about the installation process. Understanding the Installation Process 
on page 22

Plan where you will install the 
product.

Planning Your Installation Location on 
page 23

Make an installation or upgrade 
plan.

Planning the Installation or Upgrade 
Process on page 24

Log in with appropriate privileges. Logging In with Appropriate Privileges 
on page 27

Define or ensure that you have 
defined the ClearCase 
administrator’s group and the 
ClearCase Server Process User.

Defining Domain Accounts on page 27

Create or select a release area location 
and share the directory.

Select and Share a Release Area Location 
on page 28

Install Internet Explorer. Installing Internet Explorer on page 28

Table 2 Preinstallation Checklist

Done Task Reference
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Reviewing the Release Notes

Before beginning the installation process, review the Release Notes for Rational 
ClearCase and ClearCase MultiSite for any recent changes and additions to the 
material in this manual. The Release Notes are available on the product CD in the 
\ClearCase\doc directory. They are also available in the release area, following product 
installation.

System Requirements

Use this section to determine compatibility of your platforms, file system, hardware, 
software, and network before you install ClearCase. 

See the Release Notes for the latest updates.

Supported Platforms

Version 2003.06.00 of ClearCase and MultiSite run on the platforms listed in Table 3.

Supported Platforms for Rational Web Platform

The Rational Web Platform (RWP) provides support for Web interfaces to Rational 
ClearCase and other Rational products. All supported ClearCase platforms support 
RWP. RWP is installed by default on all servers.

Table 3 Supported Platforms for ClearCase and MultiSite

Hardware platform Operating system

Intel x86 Windows NT 4.0 SP6a (but not 4.0 SP6) and SRP – 
Security roll up Package, (Microsoft Knowledge Base 
Article - Q299444)

Windows 2000 SP2, SP3
Windows XP Professional SP11

Windows Server 20032

1. Rational ClearCase 2003.06.00 clients support the latest Windows 2000, Windows NT, and 
Windows XP Professional releases. Older releases of Windows, such as Windows 95, Windows 
98, Windows Me, and Windows NT 4.0 SP4, are no longer supported with this release. We do not 
support Windows XP Home Edition. Customers who require support for earlier releases of 
Windows must run an earlier version of ClearCase that supports those releases

2. The ClearCase Mainframe Connectors Remote Build Feature has not yet been tested with 
Windows Server 2003.
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The host must have adequate disk space available for the Web views that are created 
by ClearCase Web interface users. Rational recommends 0.5 - 1MB of space per view.

Supported Platforms for ClearCase Mainframe Connectors 
Remote Build Feature

If you plan to install the ClearCase Mainframe Connectors Remote Build Feature, see 
the appropriate tables for platform requirements for the client (Table 3) and server 
(Table 4). You must use TCP/IP to use this feature.

For more information, see the User's Guide for Rational ClearCase MainFrame 
Connectors.

Supported File Systems

Table 5 lists the file systems that ClearCase supports.

Windows/UNIX Interoperation

This section provides information about ClearCase support for file access between 
Windows and UNIX platforms, as it pertains to version 2003.06.00. As of this release, 
ClearCase supports these Windows/UNIX interoperation products:

■ ClearCase File Server

Table 4 Server Requirements for ClearCase Mainframe Connectors Remote 
Build Feature

Hardware platform Operating system

IBM System/390 OS/390 2.10, including UNIX System Services (USS)

IBM zSeries OS/390 2.10, including USS

z/OS 1.3, including USS

Table 5 Supported File Systems by Platform

Platform Supported file systems

Windows NT FAT, NTFS, LANMAN, NFS1 

Windows 2000 FAT, FAT32, NTFS, LANMAN 

Windows XP FAT, FAT32, NTFS, LANMAN 

1. See Table 6 for more information about NFS platforms 
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■ The third-party NFS client products listed in Table 6

■ The third-party SMB server products listed in Table 7

For more information about using these products with ClearCase, see the 
Administrator’s Guide for Rational ClearCase.

Disk Space Requirements

This section describes disk space requirements for running Rational ClearCase and 
ClearCase MultiSite. 

Table 6 Supported NFS Client Products for Windows

Product Supported product releases

Hummingbird NFS Maestro 7.0.0.1, 7.1.0.6, 8.0.0.4

Shaffer Solutions Corporation DiskAccess 5.0 or 5.1

Table 7 Supported SMB Server Products for Windows NT

Product Platform
Supported product 
releases

LSI Logic Storage Systems 
TotalNET Advanced 
Server (TAS)

Solaris 2.6 or later 5.4.1 patch 3, 

6.0, 6.1, 7.0

HP-UX 11.0 or later 5.4.1 patch 3; 6.0, 6.1, 7.0

AIX 4.3.2 and above TAS 6.0, 7.0

SAMBA (available from 
http://www.samba.org)

Solaris 8 or later SAMBA 2.0.7, 2.2, 2.2.6, 
2.2.7a, 2.2.8

HP-UX 11.0 or later Samba 2.0.7, 2.2, 2.2.6, 
2.2.7a, 2.2.8

AIX 5.1 Samba 2.2, 2.2.6, 2.2.7a, 
2.2.8

Linux RedHat 7.2 Samba 2.2, 2.2.6, 2.2.7a, 
2.2.8
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Disk Space Requirements for the Release Area

The file system of the networkwide release host must have sufficient disk space to hold 
the release area. The minimum disk space required for each release area is 200 MB.

Disk Space Requirements for Individual Hosts

Table 8 shows the approximate disk space requirements for a new installation of 
ClearCase. These figures are for ClearCase files and upgraded system files only. The 
installation also needs 15 MB of temporary disk space.

In addition, snapshot view directories need enough disk space to contain all files 
loaded into the snapshot views and all view-private files added to the views. The 
amount of space required depends on the number and size of the files in the views.

Any host that must contain VOB storage or view storage directories must have enough 
disk space to contain the files and databases used for storage of these directories. The 
amount of space required depends on the characteristics and use of the VOBs and 
views.

Software Requirements 

ClearCase and MultiSite require additional software:

■ Windows workstation or Windows server.

■ A Web browser, either Netscape (version 7.0) or Internet Explorer (5.5, or 6.0). 
Internet Explorer does not have to be the default browser, but is required for some 
ClearCase features, including the ClearCase Explorer, the HTML DiffMerge tool, 
and the ClearCase Administration Console. Rational recommends using Internet 
Explorer 5.5 SP2 or later. 

Table 8 Disk Space Required for ClearCase Files and Upgraded System Files

ClearCase installation type Disk space required

Windows NT, Windows XP, and Windows 2000 client 
or server using standard installation with dynamic 
views (5 MB additional to support MVFS installation), 
local VOBs, and local views

200 MB

Windows NT, Windows XP, and Windows 2000 client 
or server with all optional components

240 MB
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■ IIS Web server software and the FrontPage Server Extensions (FPSE) are required if 
acting as a server for the ClearCase integrations with Microsoft FrontPage 98, 
Microsoft FrontPage 2000, or Visual InterDev. 

Windows Server Software and ClearCase Servers 

Windows workstations impose a limitation on concurrent access: a maximum of 10 
systems can access a Windows system simultaneously by means of file system mounts 
or UNC names. If you anticipate this level of use, install Windows server software on 
your primary ClearCase servers. 

Using ClearCase and Windows Domains 

ClearCase is a distributed client/server application; many operations initiated on 
client hosts are completed by server processes elsewhere in the network. Therefore, all 
ClearCase hosts running Windows must belong to a Windows domain or an Active 
Directory domain, except when running a single-host evaluation copy of ClearCase.

To use ClearCase from a supported Windows host, you must log on to a domain 
account (not a local, per-system user account). For more information about Windows 
Domains, see the Administrator’s Guide.

Operating System Vendor Web Site

You can find up-to-date information about Microsoft Windows operating system 
issues at the Microsoft Web site, http://www.microsoft.com.

Setting Up Your Environment for ClearCase

The proper system infrastructure is critical if you are setting up a new ClearCase 
environment.

ClearCase Host Types

When you install ClearCase on a computer, you specify whether to configure the 
computer as a server or a client:

■ A server is a reliable computer that supports VOBs and views that are accessed by 
other computers on a local area network. 

■ A client is a computer on which a ClearCase user works, typically using one or 
more views to access VOBs on servers.
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Various system tasks are assigned to server hosts. Use these descriptions to understand 
and plan the number and types of each host you need to allocate for your installation. 
You can designate a single computer as the server that handles multiple server 
functions. For more information, see the Administrator’s Guide.

■ Server host. Any host on which a VOB or view is created is a server host. Some 
hosts may be dedicated servers on which client software is rarely used. Other 
server hosts double as clients. All server hosts, as well as the registry and license 
server host, must run ClearCase.

■ Registry server host. One host in the network acts as the ClearCase registry server 
host. Each host is assigned to a particular registry server host at ClearCase 
installation time. This host stores access-path information for all the VOBs and 
views in the network. ClearCase client and server programs on all hosts 
communicate with the registry server when accessing ClearCase data. See Setting 
Up the Registry and License Server Hosts for the First Time on page 24 and Upgrading 
ClearCase Hosts on page 25 for details about setting up a registry server host.

■ License server host. One or more hosts in the network act as license server hosts, 
authorizing and limiting ClearCase use according to the terms of your license 
agreement. Each host on which ClearCase is installed is assigned to a particular 
license server host and communicates with that host periodically. See Setting Up 
the Registry and License Server Hosts for the First Time on page 24 and Upgrading 
ClearCase Hosts on page 25 for details about setting up a license server host.

■ Networkwide release host. One host in the network acts as the networkwide 
release host. A directory on this host stores an entire ClearCase release that has 
been extracted from distribution media or downloaded from Rational. When 
necessary, patches can be applied to a release area to update the entire release with 
the latest enhancements and defect fixes. The networkwide release host does not 
need to run ClearCase.

■ Rational Web Platform (RWP) host. If you want to use the ClearCase Web 
interface, you need at least one RWP host. 

Rational recommends that the RWP server host have an additional 128 MB of 
physical memory beyond what is required to support any VOBs and views on the 
host. Unless the RWP host is the ClearCase LT server, we do not recommend using 
the RWP host as a VOB- or view-server host. RWP is installed automatically with 
ClearCase LT.

Caution: Installing RWP on a host that is already running another Web server may 
result in a port conflict that can cause RWP or the other Web server to fail on 
startup. Rational recommends that you install RWP on a host that does not have to 
run any other Web servers. If this is impossible, configure the other Web server to 
use ports that are not being used by RWP. The default port number used by RWP is 
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80. If you cannot use this port for RWP, you must configure RWP to use another 
port by running the Site Preparation Tool (see Chapter 3, Creating a Release Area). 

For more details about RWP, see the Administrator’s Guide for Rational ClearCase.

Designating Server and Client Hosts

If you are setting up a ClearCase installation for the first time, Rational recommends 
that you designate and configure the registry and license server hosts first. You can 
install the registry and license server hosts on the same computer or on different 
computers.

You must first set up the registry and license server hosts by creating a release area and 
installing the hosts from that release area, using a set of site defaults that you define. 
After you set up the registry and license server hosts, you configure other server hosts 
where clients can create VOBs and views.

You must also designate the computers you use as clients. All Windows clients can 
support dynamic views (if you have installed MVFS), local VOBs, and snapshot views.

The features installed on a ClearCase computer depend on site defaults chosen by the 
administrator. Users can override these defaults in the installation process.

VOB Database Schema Versions

ClearCase supports two VOB database schema versions: the older format (schema 
version 53) and the newer format (schema version 54).

Choosing schema version 54 format provides these features:

■ Improved support for Windows security.

■ Active Directory support. Schema version 54 is required when using ClearCase in 
Active Directory environments.

■ Files can expand beyond 2 GB in the VOB database.

If you are an existing ClearCase customer, choose the format you currently use. Run 
the cleartool –ver command to see the current VOB database schema version.

If you are a new ClearCase customer, choose schema version 54 (the default).

Note: If you are currently using schema version 53 and select schema version 54, you 
must reformat your VOBs to use the newer format. Until you do, users cannot access 
VOB data. For more information about reformatting your VOBs, see the Administrator’s 
Guide for Rational ClearCase.
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If you have an existing ClearCase installation that uses schema version 53 and you 
select the same VOB format for this installation, and then change your mind, you can 
reinstall ClearCase, select schema version 54, and reformat your VOBs.

If you have an existing installation that uses schema version 53 and you select schema 
version 54 for this installation but change your mind before having reformatted your 
VOBs, you can reinstall ClearCase and select schema version 53. But if you have 
already reformatted your VOBs, you cannot revert to the older VOB format.

VOB Database Schema Versions and MultiSite

If a server host contains replicated VOBs using ClearCase MultiSite, Rational 
recommends that all servers of the same set of replicas use the same VOB format. 

See Upgrading to a New Schema Version on page 17 for more information.

Ensuring Feature Compatibility Across Versions of ClearCase

Even the simplest ClearCase operation invokes a chain that can involve several 
components. For example, the act of checking out a file element involves a client 
program (running on the developer’s workstation), which acts through a particular 
view (located on that workstation or elsewhere) and uses a particular VOB (typically 
located on a dedicated server host). If all hosts in this operation are running the same 
ClearCase version, compatibility is guaranteed.

Table 9, Table 10, and Table 11 show the compatibility paths when all hosts are not 
running the same ClearCase version. In these tables, client means ClearCase client 
software. In each table, a component in a row can use a component in a column if there 
is a yes at the intersection of the row and column. For example, Table 9 shows that a 
2002.05.00 view can use a 2002.05.00 VOB or a 2003.06.00 VOB, but a 2003.06.00 view 
cannot use a 2002.05.00 VOB.

Table 9 Compatibility: Views with VOBs

4.2 VOB 2002.05.00 VOB 2003.06.00 VOB

4.2 view yes yes yes

2002.05.00 view no yes yes

2003.06.00 view no no yes
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Specifically, these tables make these points: 

■ ClearCase 2003.06.00 clients can use only views and VOBs that reside on ClearCase 
2003.06.00 hosts. 

■ ClearCase 2002.05.00 clients can use views and VOBs that reside on 2002.05.00 or 
2003.06.00 hosts. 

In general, older versions of clients can access servers that are at their same release 
levels or above, but current clients can access only servers that are at their same release 
level. A notable exception is that 2003.06.00 clients and servers can communicate with 
4.2 albd_servers to support access to license servers, and other administrative 
functions.

A version 2003.06.00 client on UNIX can access a VOB on Windows by using a snapshot 
view. However, the snapshot view storage directory and the VOB storage directory 
must be on servers running version 2003.06.00 or later. 

Planning for MultiSite Installation

You can install ClearCase MultiSite only on ClearCase server hosts.

MultiSite need not be installed on all ClearCase computers. In most cases, only the 
following computers require MultiSite installation:

Table 10 Compatibility: Clients with Views

4.2 view 2002.05.00 view 2003.06.00 view

4.2 client yes yes yes

2002.05.00 client no yes yes

2003.06.00 client no no yes

Table 11 Compatibility: Clients with VOBs

4.2 VOB 2002.05.00 VOB 2003.06.00 VOB

4.2 client yes yes yes

2002.05.00 client no yes yes

2003.06.00 client no no yes
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■ Computers on which one or more replicated VOBs reside.

■ Computers that belong to users with ClearCase and MultiSite administration 
responsibilities.

■ Computers on which the shipping_server utility is used, even if no replicated 
VOBs reside on that computer. Running shipping_server does not require a 
MultiSite license. For more information about this utility, see the Administrator’s 
Guide for Rational ClearCase MultiSite.

You do not need to upgrade all servers used by a set of replicas of a particular VOB (a 
VOB family) at the same time.

Ensuring MultiSite Compatibility with ClearCase

ClearCase MultiSite is layered on ClearCase. To use MultiSite on a host running 
version 2003.06.00 of ClearCase, you must be running version 2003.06.00 of MultiSite. 
ClearCase MultiSite version 2003.06.00 is fully compatible with ClearCase version 
2003.06.00 client and server hosts: 

■ A MultiSite version 2003.06.00 replicated VOB can reside on any ClearCase version 
2003.06.00 server host. 

■ Any ClearCase version 2003.06.00 client program can access and modify any 
replicated VOB residing on a ClearCase version 2003.06.00 server host. Other client 
VOB access is the same as that documented in Ensuring Feature Compatibility Across 
Versions of ClearCase on page 14.

ClearCase, ClearQuest, and Rational Shipping Server Considerations

The Rational Shipping Server is required by both Rational ClearCase MultiSite and 
Rational ClearQuest MultiSite. It should be installed only on those hosts that are 
responsible for replicating data to other sites. 

Rational recommends that you avoid configuring any one host to run the Shipping 
Server for both products, because de-installing either product from such a host will 
remove the Shipping Server that is used by both products and render the remaining 
product inoperable. 

If you must install both ClearCase MultiSite and ClearQuest with the Shipping Server 
on the same host, ensure you do the following:

■ Install ClearCase first

■ Uninstall both products if you ever uninstall either product

Note: Administrators should be sure that site configuration files for typical host 
systems do not specify installation of the Rational Shipping Server. Any attempt to 
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install ClearCase on a host where ClearQuest and the Shipping Server is already 
installed will fail. 

Compatibility Issues Across MultiSite Versions

The following sections describe compatibility restrictions and issues when different 
sites are running different MultiSite versions. 

Replica Creation 

There are compatibility restrictions on creating replicas. You can replicate a VOB to a 
host running an earlier version of ClearCase MultiSite only if the feature level of the 
VOB is supported by the ClearCase release on the target host. 

For example, if a host is running ClearCase version 2003.06.00 and has a VOB whose 
feature level is 2, you can replicate that VOB to a host running ClearCase 4.2. Similarly, 
if a host is running ClearCase version 2003.06.00 and has a VOB replica whose VOB 
family feature level is 3, you can export a replica-creation packet from that replica and 
import it on a host running ClearCase version 2002.05.00. However, you cannot import 
the packet on a host running ClearCase 4.2. ClearCase 4.2 does not support feature 
level 3.

Replica Synchronization 

As long as VOB feature levels are compatible, existing replicas hosted on systems 
running ClearCase 2003.06.00 can synchronize with existing replicas on systems 
running either ClearCase version 4.x or 2002.05.00. For more information about feature 
levels, see the Administrator’s Guide for Rational ClearCase MultiSite.

Upgrading to a New Schema Version 

If you decide to update one or more replicas in a VOB family to use the schema version 
54, you do not have to update all other replicas in the VOB family at the same time. 
However, you must update all other replicas in the family before any of the database 
files in the schema version 54 replicas grow larger than 2 GB, which is the largest 
database file size that can be accommodated by a schema version 53 VOB.

If you do not, synchronization imports fail at any replica that has not been updated.

Uninstalling ClearCase MultiSite or Rational Shipping Server

If you are using ClearCase MultiSite and the Rational Shipping Server on the same 
computer and you uninstall either product, one may be partially uninstalled and stop 
working. Uninstall both and reinstall the product that is needed.
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Ensuring ClearQuest Compatibility with ClearCase

ClearCase and MultiSite version 2003.06.00 can be integrated with Rational ClearQuest 
in two different ways: 

■ If you are using ClearCase with the Unified Change Management (UCM) process, 
you can enable the UCM-ClearQuest integration and use it with ClearQuest 
version 2003.06.00. 

■ If you are using base ClearCase (that is, not using the UCM process), you can 
integrate with ClearQuest 2003.06.00 by using the ClearCase-ClearQuest 
integration 1.0 package. 

Note: You must run at least version 2003.06.00 of ClearQuest on systems where 
ClearCase version 2003.06.00 is installed.

See also ClearCase, ClearQuest, and Rational Shipping Server Considerations on page 16.

Planning for ClearCase Installations on Dual-Boot Computers 

On a computer that can boot multiple Windows installations, do not install ClearCase 
in the same directory for any two installations. 

If you install to the same directory, various identical ClearCase components are shared. 
Removing ClearCase from that directory disables ClearCase for every version of 
Windows that uses the common directory. Furthermore, when a common directory is 
used, it is not possible to install different ClearCase releases for each version of 
Windows.

To avoid these problems, install ClearCase in separate directories for each version of 
the operating system. 

Enabling Remote Administration

If you enable ClearCase Remote Administration, any user who is both logged on to 
another host and a member of the ClearCase administrators group can use the 
ClearCase Administration Console to change ClearCase properties for clients and 
servers. 

Remote administration capability is useful if, for example, you move your license 
server to a new host. You can then change the settings for all clients from a single 
computer.

These ClearCase properties can be changed:

■ Registry region
■ License server
■ Registry and backup registry servers
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■ MVFS cache sizes

If you do not enable Remote Administration, only the local user can change that 
computer’s ClearCase properties.

For more information, see the Administrator’s Guide.

Ensuring Compatible Character-Encoding Systems

Because the interpretation of multibyte characters is controlled by a host’s locale 
setting (established by using the Regional Options tool in Control Panel), all tags in a 
region must use the same character set, and all hosts in a region must use the same 
locale setting. 

Allocating Licenses

This section provides an overview of license allocation. For more information about 
license servers, see the Administrator’s Guide.

The set of licenses is maintained on the license server. The network can have one or 
more license servers. Each license server runs a ClearCase server process, and so must 
have ClearCase installed. You set up your license servers during the installation. 

After you determine your initial license allocation (see Allocating ClearCase Licenses on 
page 19) fill in the appropriate number of License Registration Forms and submit them 
according to the instructions on the form. A copy of the License Registration Form is 
included at the end of this manual. You receive your license keys by return fax or 
e-mail.

Rational ClearCase and Rational ClearCase MultiSite implement an active-user 
floating license scheme. Details of how this scheme controls a user’s access to 
ClearCase and MultiSite are available in the clearlicense reference page and in the 
Administrator’s Guide for Rational ClearCase.

ClearCase and MultiSite use the same license server.

Allocating ClearCase Licenses 

Suppose that your organization has purchased 25 ClearCase licenses. You must decide 
how many license servers to use and how to allocate licenses to them. Here are two 
examples.

■ Use a single license server. In this case, request a single license authorization code 
for 25 licenses. Create a single license database incorporating this code.

A drawback of this strategy is its single point of failure. If your network’s lone 
license server fails, no one is able to use ClearCase. If you use this strategy, select a 
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reliable server and take this scenario into account when constructing a disaster 
recovery plan.

■ Use multiple license servers. In this case, request two license authorization codes, 
perhaps one for 15 licenses and another for 10 licenses. Create two license 
databases incorporating these codes, on two different servers.

This strategy provides for more robustness. If the 15-license server fails, 
developers can still use ClearCase.

Allocating MultiSite Licenses

Each user of a replicated VOB must acquire both a ClearCase license and a MultiSite 
license; moreover, the two licenses must be acquired from the same license server host. 
Therefore, plan your MultiSite licenses by analyzing each current ClearCase license 
server. 

■ If some or all users of a particular license server access replicated VOBs, you must 
install MultiSite licenses on that license server.

■ If all users access replicated VOBs, you must install the same number of MultiSite 
licenses as ClearCase licenses.

■ If some users access unreplicated VOBs only, you do not need MultiSite licenses 
for these users.

For example, a company has two sites, with 20 developers at site A and 5 developers 
at site B. The company has three VOBs at site A; two of them are replicated to site B and 
one is not replicated. Five developers at site A access only the unreplicated VOB, and 
the remaining 15 work in all VOBs. Therefore, the company needs to purchase the 
following numbers of licenses:

Note: This example assumes that you purchase a ClearCase license for each developer. 
If you have fewer ClearCase licenses than developers, you can purchase a 
proportionate number of MultiSite licenses. For example, if site B purchased three 
ClearCase licenses, it would also purchase three MultiSite licenses.

Site ClearCase licenses MultiSite licenses

A 20 15

B 5 5
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Environment-Specific Tasks

Depending on your installation environment, there may be other tasks you must 
perform or information you must be aware of, before installing ClearCase. To 
determine whether you need to perform any of these tasks, see Table 12. Some tasks 
require you to follow the procedures in Appendix C, Environment-Specific Tasks During 
Preinstallation.

Table 12 Environment Specific Tasks

Product installed Task Information

ClearCase 
integration with IBM 
Visual Age for Java

Install IBM VisualAge for 
Java and ClearCase in any 
order, and then run the IBM 
VisualAge for Java 
Integration Configuration 
Wizard. 

Installing VisualAge for Java on 
page 53

ClearCase UCM 
Integration with 
Rational ClearQuest

Before implementing the 
UCM integration with 
ClearQuest, ensure 
compatibility of product 
features.

Installation of the UCM 
Integration with Rational 
ClearQuest on page 54

ClearCase 
Integration with 
VS.NET

Install VS.NET Version 7.0 
or 7.1. Close VS.NET before 
installing ClearCase.

ClearCase installation detects 
VS.NET and installs the 
Integration automatically. 
ClearCase functions are added 
to your VS.NET IDE.

Installation of the Rational 
ClearCase VS.NET Integration 
feature can be subsequently 
omitted or modified by running 
the Rational Setup Wizard.

Expat XML Parser This product incorporates 
the Expat XML parser 1.0 
under the Mozilla 1.1 
license.

The license is available for 
browsing at 
www.mozilla.org/MPL/MPL-1.1.txt.

The source code version of the 
expat XML parser is available at 
www.jclark.com/xml/expat.html.
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Initial Installation Tasks

Before you begin the installation, perform the following tasks:

1 Learn about the installation process.

2 Plan where you will install ClearCase.

3 Make an installation or upgrade plan.

4 Log in with appropriate privileges.

5 Define domain accounts.

6 Select and share a release area location.

7 Install Internet Explorer.

Understanding the Installation Process

Before planning your installation process, review the following summary of the 
installation process.

You install ClearCase by first creating a networkwide release area, and then installing 
servers and clients from that release area, using specific sets of site defaults. You set up 
your first release area by running setup.exe from the ClearCase CD.

1 You select a location for the release area, a shared directory on your network. A 
release area contains at least one site default file and can contain multiple site 
default files.

2 You run setup.exe from the ClearCase CD and select the Enterprise deployment 
option. The Rational Setup Wizard starts.

3 You then configure ClearCase for your installation by setting site defaults with the 
Site Preparation Tool. The site defaults that you select determine the specific 
aspects of your ClearCase configuration, including MVFS performance settings, 
account information, shortcuts, and so forth.

4 After you specify your site defaults, you are prompted to save your site defaults 
file with a unique name, and also to add a meaningful description for later 
reference. A shortcut icon will be created in your release area with the name you 
chose for the site defaults file, excluding the filename suffix. The shortcut provides 
you with a convenient method of starting the installation using the saved site 
defaults, at a future time. You also have the option of starting the installation 
following creation of the release area, by selecting the Launch Installation check box 
in the Completion section of the Site Preparation Tool.

5 The wizard creates your release area.
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6 If you chose to start your installation automatically, the wizard installs the product 
with the site defaults you created in Step 3. If not, the wizard finishes, and you can 
start your installation later by executing the shortcut.

7 After you install the product using one of the methods in Step 6, you may be 
prompted to restart your computer.

8 After restart, the ClearCase Doctor and Server Storage Wizard run automatically. 
The Server Storage Wizard does not run following a client installation.

The ClearCase Doctor detects any problems with your installation and provides 
possible solutions. The Server Storage Wizard or the Getting Started Wizard assists 
you in setting up storage directories for VOB and view storage.

9 You must perform postinstallation tasks before you can begin using the product in 
a production environment. See Postinstallation Procedures on page 38 for details.

10 You can create additional site default files by running setup.exe again or by 
running siteprep.exe. See Chapter 3, Creating a Release Area for details.

11 You install ClearCase on additional servers and clients, by executing the 
appropriate shortcut created in Step 4.

Planning Your Installation Location

It is important that you take the following issues into account when planning where to 
install ClearCase:

■ All Rational products must reside in the same directory tree. For example, if you 
have Rational ClearQuest installed in C:\Program Files\Rational, you must install 
ClearCase in C:\Program Files\Rational, as well.

■ In previous releases, the name of the installation destination directory that you 
specified included the name of the product, ClearCase. In this release, specify only 
the name of the directory where you want the ClearCase directory to be created. 
The standard location for this directory is drive:\Program Files\Rational. If you 
specify ClearCase in this path (for example, C:\Program Files\Rational\ClearCase), the 
product is installed in C:\Program Files\Rational\ClearCase\ClearCase.

Ensure Installation Directory Permissions

The directory in which you install ClearCase must grant MODIFY permission to the 
built-in SYSTEM user. If this is not the case, modify your permissions accordingly.
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Planning the Installation or Upgrade Process

Because you must follow specific procedures, in a designated order, to install and 
uninstall ClearCase in your environment, create an installation or upgrade plan before 
you begin the installation process. Creating a plan now will save you valuable time 
later. 

You plan the installation of your ClearCase hosts based on whether you are installing 
ClearCase for the first time or are upgrading existing ClearCase hosts.

Important: Because all Rational products are using a new installation technology, you 
must completely uninstall all previous versions of ClearCase and all other Rational 
products for each host that you plan to install or upgrade to ClearCase version 
2003.06.00. 

Installing for the First Time

Install ClearCase on these hosts in the following order:

■ License server host

■ Registry server host

■ Server hosts

■ Client computers

As you install, be aware of the following:

Special Consideration for Registry Server Hosts

When creating your registry server, you must set your registry password. See the 
Administrator’s Guide for details about setting the registry password.

Setting Up the Registry and License Server Hosts for the First Time

If you are setting up your ClearCase environment for the first time, you must designate 
and install ClearCase on a registry server host and a license server host. You can set up 
one computer to perform both registry and license server host roles or you can use 
different computers. To set up these hosts, create a release area and modify your site 
defaults as needed using the procedures in Chapter 3, Creating a Release Area. 

As you select your site defaults, use the Administrative Information page to designate 
the current computer as the registry server. When configuring a license server, use the 
License Server Type page to enter the license keys that you received from Rational.

After you set up the registry and license server hosts, set up your server hosts in a 
similar manner. You can use the same site defaults file and release area you created 
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when you set up the registry and license server hosts; you can also create site defaults 
if you need to modify the parameters for additional server hosts.

Upgrading ClearCase Hosts

It is important to read and understand all the material in this manual before 
uninstalling or upgrading your product.

For more information about uninstalling ClearCase software and the order in which 
you must upgrade ClearCase hosts, see Planning the Installation or Upgrade Process on 
page 24.

Removing Previous Versions of ClearCase

To uninstall previous versions of ClearCase, run Add/Remove Programs from the 
Windows Control Panel.

Caution: If you have moved or removed the release area that you set up when you 
installed your previous version of ClearCase, you must run uninstal.exe from the 
product CD. In this case, you cannot run Add/Remove Programs.

General Information About Upgrading

If you are upgrading from a previous version of ClearCase to version 2003.06.00, here 
is some general information to keep in mind: 

■ Important: If possible, install the new release of ClearCase in the same directory 
path as the currently installed release. If that is not possible, see If You Are 
Reinstalling Using a New Directory Path on page 26.

■ Install the new release on server hosts (such as registry servers, VOB and view 
servers) before you install on client hosts; version 2003.06.00 clients cannot access 
servers that are running an earlier version of ClearCase. 

Planning the Order of Your Upgrade

When upgrading ClearCase hosts, uninstall and reinstall the product on these hosts, in 
this order:

■ License server host

■ Registry server host

■ Server hosts

■ Client computers

The section explains issues and considerations to be aware of when upgrading your 
ClearCase hosts.
Chapter 2 - Before You Install ClearCase 25



Special Consideration for Registry Server Hosts

When upgrading your registry server, you must set your registry password. See the 
Administrator’s Guide for details about setting the registry password.

General Considerations for Upgrading All Server Hosts

■ Make sure that all views and VOBs are fully backed up. For information about 
backing up views and VOBs, see the Administrator’s Guide.

■ If you have modified any files in ccase-home-dir (by default, C:\Program 

Files\Rational\ClearCase), you must save them before installing ClearCase.

■ During the uninstall process, you will be asked if you want to preserve the var 
directory. Click Yes.

■ During the uninstall process, you will be asked if you want to delete the Start 
menu folders. Click Yes.

■ Before upgrading your license server, copy your license key string to another 
location, such as a text file. When you install your new license server, you can then 
copy the string from the text file, for convenience.

If You Are Reinstalling Using a New Directory Path

When upgrading, if you cannot install ClearCase in the same directory tree as the 
previous release, it is important that you preserve the \var directory as described in 
General Considerations for Upgrading All Server Hosts on page 26. You also must copy any 
changed elements from the \var directory in the old ClearCase installation to the \var 
directory in the new installation. 

These elements include:

■ ClearCase registry database, if the server is a ClearCase registry server, (found in 
\var\rgy).

■ Registry client list (\var\client_list.db).

■ Job scheduler database (\var\scheduler).

■ Standard job scripts that may have changed (\var\scheduler).

■ Data in shipping bays, if using MultiSite (\var\shipping).

■ Any custom job scripts.
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Logging In with Appropriate Privileges

To install ClearCase, you must log on with appropriate privileges. You must be logged 
on to a Windows domain account that is a member of the local host's Administrators 
group.

Defining Domain Accounts

It is necessary to define a ClearCase users group. All users who perform routine 
ClearCase operations using a common set of VOBs and views must belong to this 
group. It can be an existing domain global group or one created specifically for this 
purpose.

The ClearCase users group must have the following characteristics:

■ It must be a domain global group or an Active Directory universal group. Rational 
recommends that you use a domain global group unless you are using Active 
Directory and the group needs to include other groups. 

■ If members of the group must access VOBs or views on a UNIX host, the group 
name must be the same as the name of the ClearCase users group on UNIX. For 
more information, see the Administrator’s Guide.

A ClearCase community requires two additional domain accounts:

■ A ClearCase server process user. The albd_server program runs with this identity. 
In examples throughout this document, the ClearCase server process user is 
clearcase_albd. The ClearCase server process user must be a member of the 
ClearCase administrators group.

■ A ClearCase administrators group. Members of this group can perform all 
ClearCase operations, including those that permanently destroy data. 
Membership in this group must be restricted to the ClearCase server process user 
and a few ClearCase administrators.

If you have domain administrator privileges, the ClearCase server process user and 
ClearCase administrators group will be created for you during the site preparation 
process.

Note: If you do not have domain administrator privileges, you must create the accounts 
manually before you create a release area. For more information, see Defining Required 
Domain Accounts Manually on page 27.

Defining Required Domain Accounts Manually

If the user who configures ClearCase site defaults does not have domain administrator 
privileges, the wizard cannot create these accounts. A domain administrator must 
create them as follows:
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1 Log on as a user with domain administrator privileges.

2 Using the appropriate domain user and group account management tool, create a 
new global group called clearcase (or another group name the community has 
chosen). In the Description box, type the following text:

Used exclusively by ClearCase server processes and administrators. 

3 Create a new user, clearcase_albd (or another user name the community has 
chosen), and put the group name defined in Step 2 in the new user’s group list. 

❑ Select the Password never expires check box.

❑ In the Description box, type the following text:

Used exclusively by ClearCase servers 

❑ On each ClearCase host that is configured to support local VOBs and views, give 
the clearcase_albd user the right to log on as a service.

Nondomain Installations

Except when evaluating ClearCase, we do not recommend installing it on nondomain 
systems. For more information about using ClearCase on nondomain systems, see the 
Administrator’s Guide for Rational ClearCase.

Select and Share a Release Area Location

Determine a location for the release area from which you will install ClearCase. Make 
the release area directory shareable across your network. Even if the drive containing 
that directory is already shareable, making the directory itself shareable makes it easier 
to find the ClearCase release area. Restrict write permission to the directory to the 
administrator.

1 In Windows Explorer, right-click the network release area to display the directory 
shortcut menu.

2 Click Sharing. The Properties dialog box opens.

3 On the Sharing tab, click Shared As and supply a meaningful share name, such as 
CC60 Release Area.

You will specify the release area location when you run the Rational Setup Wizard to 
install the product.

Installing Internet Explorer

To function correctly, the ClearCase Explorer, the ClearCase HTML Diff Merge tool, the 
ClearCase Automation Library (CAL) documentation, and the ClearCase 
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Administration Console, including its Help, require Internet Explorer Version 5.5 
Service Pack 2 (SP2) or later. Moreover, the Microsoft Management Console (which is 
used by the ClearCase Administration Console) may not install correctly without 
Internet Explorer Version 5.5 SP2 or later. 

You can download and install Internet Explorer from the Microsoft Web site:

www.microsoft.com/windows/IE 

For more information, see Enabling Remote Administration on page 18.
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3Creating a Release 
Area
When you install Rational ClearCase, you first create a networkwide release area. You 
then install the product on servers and clients, from the release area you have created. 

This chapter explains how to set up a release area and create site default files by using 
the Enterprise deployment option. 

Note: If you are upgrading from Rational ClearCase LT, follow the procedures in 
Appendix D, Upgrading from ClearCase LT. You will be directed to follow the procedures 
in the rest of the book from Appendix D, as required.

Before You Begin

Table 13 lists the tasks and information you need before you run setup.exe for the first 
time.

Table 13 PreInstallation Checklist for Enterprise Deployment of ClearCase

Done Task Information

Review release notes. Reviewing the Release Notes on page 7

Review and complete all 
preinstallation requirements.

Chapter 2, Before You Install ClearCase

Obtain your license keys in 
preparation for configuring the 
ClearCase License Server. Remember 
to obtain keys for all ClearCase LT 
users or hosts you plan to upgrade.

Allocating Licenses on page 19

Ensure that you are logged on with 
appropriate privileges. You must be 
logged on to a Windows domain 
account that is also a member of the 
local host's Administrators group.

For more information about setting 
up the appropriate domain accounts 
and the Administrators group, see 
Defining Domain Accounts on page 27
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Running the Rational Setup Wizard

Use the Rational Setup Wizard to create your release area. 

You must run the Rational Setup Wizard from the CD. After you have set up your 
release area, you can execute the shortcut (created in Step 4 in Understanding the 
Installation Process on page 22) to install additional servers and clients. 

Run the Rational Setup Wizard from the CD:

1 Insert the ClearCase CD into the CD drive. The setup program starts and the 
Welcome to the Setup Wizard page opens. Click Next.

2 On the Deployment Type page, select Enterprise deployment. Click Next.

3 Specify your site defaults.

The left pane of the Site Preparation Tool contains a tree structure you can use to 
navigate between the various site default selection pages. The page names in the 
left pane marked with a red dot contain required fields that must be completed 
before the Done button is available.

After you specify your site defaults, you must also complete the following pages in 
the Completion section:

❑ Description - Enter a short description of your configuration on this page. This 
is helpful documentation for others who may need to later use or modify your 
site defaults.

❑ Create Release Area - Specify the pathname of your release area, as indicated, 
and the name of your site defaults file. The site defaults file is stored in the 
release area.

Note: Your release area must be shared. For more information, see Select and 
Share a Release Area Location on page 28. The release area must be accessible by 
all of your users.

Choose a meaningful name for your site defaults file (for example, QE_Server.dat 
or client.dat); a shortcut with the same name will be created in the release area, 
excluding the filename suffix. You can then use the shortcut to install the 
product from the release area with these site defaults.

❑ Launch Installation - Select the check box on this page to start the ClearCase 
installation with the site defaults you have specified. 

Note: If you do not select the check box, you can install the product at a later 
time, using the shortcut. 
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You can advance the pages in the Site Preparation Tool by clicking Next, or by 
clicking the name of the desired page using the left, navigational pane of the tool. 
When you complete all pages, click Done.

Detailed information about completing the pages in the Site Preparation Tool is 
available in the Help.

4 On the Configure and Setup Release Area page, click Next.

The Create a Release Area page appears and indicates progress as your release 
area is created.

5 The Setup Complete page appears. Click Finish to proceed.

Your release area has now been created. 

For instructions about installing from your release area and completing your 
installation, see Installing Servers and Clients from a Release Area on page 35.

Creating Additional Site Defaults for a Release Area

You can construct several different site defaults files for your installation. You must 
create one site defaults file to be used for server installations, and another for client 
installations.

Optionally, some sites will require multiple server site defaults to be set up, based on 
the different needs of various user groups. For example, a development group and a 
quality engineering group may use different Start menu commands or different 
registry servers, requiring separate site default files for each group.

Create multiple site defaults for a release area by doing the following:

1 Create the site default files.

2 Save the site default files with unique names.

3 Execute the shortcut for the site defaults you want to install with.

Creating the Site Default File

Create multiple site defaults for a release area:

1 Create your initial release area by installing the product using the procedure in 
Running the Rational Setup Wizard on page 32.

2 Run the ClearCase Site Preparation Tool by executing siteprep.exe in your release 
area or by running siteprep.exe on the command line. 
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3 After you complete all required fields in the Site Preparation Tool, click Finish. The 
Save As dialog box opens.

Saving the Site Defaults File

After you run Site Preparation by running siteprep.exe you must save your site 
defaults file for future use.

1 In the Save As dialog box, enter the location of the release area and enter a unique 
name for the new site defaults file in the File name box. A shortcut will be created 
with the same name in the release area, excluding the filename suffix. You can then 
execute the shortcut to install the product from the release area with your selected 
site defaults.

2 Click Save.

Installing Using the Site Defaults File

To install a server or client using the newly created site defaults file, see Starting the 
Installation from the Command Line on page 37.
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4Installing from a 
Release Area
This chapter explains how to complete the installation process by installing servers and 
clients from the release area you created in Chapter 3. 

Installing Servers and Clients from a Release Area

Install servers and clients in one of the following ways:

■ Execute the shortcut that is associated with your chosen set of site defaults. This 
shortcut is in your release area.

■ Start the installation automatically when running the Rational Setup Wizard.

■ Run setup.exe from the command line.

Starting the Installation by Using a Shortcut

If you have set up a release area and want to install a ClearCase server or client host 
using previously defined site defaults, execute the appropriate shortcut in the release 
area. The shortcut name will be the same as the site default file name you selected in 
Step 3 of Running the Rational Setup Wizard on page 32

Double-click the shortcut and follow the instructions in Starting the Installation from the 
Rational Setup Wizard on page 35.

Starting the Installation from the Rational Setup Wizard

If you chose to start the installation after creating your site defaults, as described in 
Step 3 of Running the Rational Setup Wizard on page 32, and you are currently running 
the Rational Setup Wizard, follow these steps to complete the installation process.

1 When the installation starts, The Welcome to the Setup Wizard for Rational 
ClearCase page appears, indicating that you are ready to begin installing the 
product from the release area. Click Next.

2 If the Product Warning page appears, you must correct the problems it lists on this 
computer before proceeding. Click Next to proceed, or click Cancel to correct 
problems.
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3 On the License Agreement page, read the license agreement. If you accept the 
terms, select I accept the terms in the license agreement. To view any third-party 
product terms, click View. Click Next when you are ready to proceed.

4 On the Destination Folder page, specify the directory in which to install ClearCase. 
Files are copied to the default location in the ClearCase folder. For example, if the 
default location is drive:\Program Files\Rational, the files are copied to drive:\Program 

Files\Rational\ClearCase. 

Click Change to install to another location.

Note: If the Change button is unavailable, other Rational products are installed on 
your system. In this case, you must use the default pathname listed. 

For more information about recommended product location, see Planning Your 
Installation Location on page 23.

5 The Site Default Configuration page appears with the description you entered 
earlier when you created your release area. 

Select one of the following options:

Use the standard configuration - Use this option to install the product with the site 
defaults you specified when you created the release area. If you select this option, 
go to Step 7.

I will create my own custom configuration - Use this option to override site defaults 
and specify how product features are installed. Verify any plans to customize your 
configuration with your system administrator before proceeding to do so. For 
information about using the Custom Setup page, see Step 6. 

6 On the Custom Setup page, specify how to install and configure the product 
features:

a Select the option from the product tree on the left. You can expand or collapse 
the tree to show or hide product features.

b Click the disk drive icon to the left of the product feature name. Choose one of 
three installation options

This feature will be installed on local hard drive - Selecting this option installs the 
selected product feature on your computer’s disk drive.

This feature, and all subfeatures, will be installed on local hard drive - Selecting 
this option installs the selected product feature, as well as all features and 
subfeatures in the product tree below the selection, on your computer’s disk 
drive.

This feature will not be available - Selecting this option does not install the 
product feature on your computer’s disk drive.
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c Click Next. Based on your customization, you may choose to modify your site 
defaults again. To do this, use the configuration tool and either save these 
defaults using a new filename or continue to install using these defaults. When 
finished, click Done.

7 The Ready to Install the Program page appears. Click Install to begin copying the 
product installation files. The Installing Rational ClearCase page indicates 
installation progress.

8 The Setup Complete page appears when all installation files are copied. 
Optionally, select the appropriate check box to view the release notes or to go to 
the Rational Developer Network. 

Click Finish.

9 After you restart the system as prompted, and log on, the installation completes 
and the ClearCase Doctor and Server Storage Wizard appear.

Starting the Installation from the Command Line

You can also run setup.exe from the command line. To do so, enter: 

path\setup.exe path\sitedefs.dat

Note: You must specify the absolute or relative location of setup.exe and your site 
defaults file, unless you run setup.exe from the release area.

Follow the instructions in Starting the Installation from the Rational Setup Wizard on 
page 35.

Configuring Storage with the Server Storage Wizard

If you specified that your computer is to be a ClearCase server, the ClearCase Server 
Storage Configuration Wizard runs when you first log on after the installation restart.

This wizard allows you to specify locations on the server that are available to 
ClearCase clients for VOB and view storage directories. 

You must log on with the same user ID that you used to run the installation.

You can configure the locations by using the wizard now or wait until the next logon. 
On the next logon, you can configure the locations from the ClearCase Registry snap-in 
of the ClearCase Administration Console. You can also run 
ccase-home-dir\etc\SvrStor.exe or the mkstgloc command from the cleartool 
command line.
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The Help for the wizard provides configuration details. For more information about 
storage configuration, see the Administrator’s Guide.

Note: If you are setting up a new environment for use by a small development team, 
you may want to use the Getting Started Wizard, instead of the Server Storage Wizard. 
See Using the Getting Started Wizard on page 40 for more information.

Postinstallation Procedures

After the installation is complete, you may perform several postinstallation 
procedures.

Table 14 lists the possible scenarios where additional tasks may need to be performed, 
and information about those tasks.

Table 14 Additional Enterprise Deployment Postinstallation Tasks

Scenario Information about task

You support ClearCase users who are members 
of multiple domain groups.

Setting the ClearCase Primary Group 
on page 39

You use the FrontPage Web Authoring 
integration.

Reinstalling the FrontPage Web 
Authoring Integration on page 39

Your VOB, view, registry, or license server hosts 
will be accessed by UNIX clients.

Specifying Windows Domain for 
Credential Mapping of UNIX Users 
on page 40

You are upgrading a server that hosts schema 
version 53 VOBs, and you chose schema version 
54 during installation.

Reformatting for VOB Database 
Schema Version 54 on page 40

You need to raise the feature level. The Administrator’s Guide and the 
Release Notes.

You use other product integrations not 
mentioned specifically in this chapter.

See the Help for your specific 
product Integration tool for more 
information about enabling your 
integration following installation 
of ClearCase.

You are a new ClearQuest user, and want to set 
up ClearQuest (and optionally the UCM 
integration with ClearQuest) for a small team

Using the Getting Started Wizard on 
page 40
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Setting the ClearCase Primary Group

Although you can designate a user’s primary group by using various Windows 
domain account maintenance tools, that group name is not always returned when an 
application requests the name of a user’s primary group (unless the user is a member 
of only one domain group). 

ClearCase users who are members of multiple domain groups must set the user 
environment variable CLEARCASE_PRIMARY_GROUP to the domain-qualified name of 
the ClearCase users group (for example, NT_WEST\clearusers). This guarantees an 
unambiguous definition of the group that ClearCase considers the user’s primary 
group. ClearCase users who are members of a single domain group do not have to take 
this step.

Note: CLEARCASE_PRIMARY_GROUP must be a user environment variable. It cannot be 
a system environment variable.

To verify that CLEARCASE_PRIMARY_GROUP has been properly set:

1 Click Start > Programs > Rational Software > ClearCase > Administration > 
ClearCase Doctor.

2 Click Start Analysis.

3 When the analysis is finished, click the Topics tab and open the User Login Account 
folder.

4 Double-click Primary Group, read the user’s primary group, and verify that it is 
correct.

For more information, see the Administrator’s Guide.

Reinstalling the FrontPage Web Authoring Integration

If you use the FrontPage Web Authoring integration, you need to reinstall it after 
installing ClearCase version 2003.06.00.

To reinstall the integration:

1 Click Start > Programs > Rational Software > Rational ClearCase > Administration > 
Integrations > Web Authoring Integration Configuration. The Web Authoring 
Integration Wizard starts.

2 Select Enable source control integration for Web projects. Click Next.

3 Select Local Mode Configuration. Click Next.
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4 Choose to either replace SourceSafe with ClearCase or use SourceSafe as your 
source control provider. Then, on the Replace SourceSafe page, select the 
appropriate option. Click Next.

5 Click Finish to close the wizard.

The FrontPage Web Authoring integration has now been reinstalled.

Specifying Windows Domain for Credential Mapping of UNIX 
Users

If your VOB, view, registry, or license server hosts will be accessed by UNIX clients, 
you must specify the Windows domain that will be used to map the credentials of 
UNIX users. 

Specify the Windows domain for credential mapping:

1 Click Start > Settings > Control Panel.

2 Double-click ClearCase and click the Options tab.

3 In the Use this domain to map UNIX user and group names area, select a Windows 
domain in which user and group identities have been defined for all UNIX users 
who access these services on this server. 

Reformatting for VOB Database Schema Version 54

If you have installed ClearCase version 2003.06.00 on a host that supports VOBs 
formatted with schema version 53, and you selected schema version 54 during 
installation, you must reformat your VOBs to be using the newer format. Until you do, 
you cannot access your VOB data.

For more information about formatting your VOBs, see the Administrator’s Guide and 
the reformatvob command in the Command Reference for Rational ClearCase.

Using the Getting Started Wizard

The Getting Started Wizard is intended for new customers who want to configure 
ClearQuest, set up storage for VOBs and views in ClearCase, or enable the UCM 
integration for use by a small development team. 

For best performance, Rational recommends that you keep view_server processes 
(especially those that support dynamic views) off of server hosts, so you may want to 
limit the number of additional dynamic views you create on the server after the Getting 
Started Wizard has run. 
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To run the Wizard, click Start > Programs > Rational Software > Rational ClearCase > 
Administration > Getting Started Wizard.

If you use the Getting Started Wizard, you do not have to configure storage using the 
Server Storage Wizard (see Configuring Storage with the Server Storage Wizard on 
page 37).

For help with using the Getting Started Wizard, see the browser-based Help in the left 
pane of the Wizard.

Enabling MultiSite Synchronization

You enable ClearCase MultiSite by selecting the option on the Features page in the Site 
Preparation Tool.

For information about replicating VOBs and automating synchronization among 
replicas, see the Administrator’s Guide for Rational ClearCase MultiSite.

If Your Installation Was Not Successful

If your installation did not finish with the desired result:

■ View the log output for error messages and more information.

■ Diagnose probable causes of errors with ClearCase Doctor, if installed.

■ Run setup.exe to modify, repair, or remove the installation.

Viewing the ClearCase Log

The ClearCase installation process automatically generates a log file that includes basic 
information about the details of the installation and any errors generated from the 
process.

ClearCase stores the log file in the temporary directory specified by the TEMP 
environment variable (EV). To locate and view the log file:

1 Open a command window.

2 Enter this command: echo %temp%. The command returns the temp directory 
specified by the TEMP EV.

3 Navigate to the temporary directory specified by the TEMP EV with Windows 
Explorer. The rational_install.log file is written in UTF-8 format and can be read by 
using Windows Notepad.
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Note: To view the log (rational_install.log), you must ensure that you are displaying 
hidden system files if you are using Windows Explorer.

Diagnosing Errors with ClearCase Doctor

ClearCase Doctor can analyze your ClearCase servers and clients for existing and 
potential problems. 

ClearCase Doctor is run by the Rational Setup Wizard before installing a new version 
of ClearCase; it also runs on a new installation after you log on. Thereafter, you can set 
ClearCase Doctor to run each time you log on (the default), turn it off entirely, or run it 
in the background. At a minimum, Rational recommends that you run ClearCase 
Doctor in the background so that it can detect changes in your ClearCase environment 
that may affect operations.

ClearCase Doctor checks basic configuration information for a site or an individual 
computer. If it finds a problem, it suggests a solution and often offers to fix the problem 
for you.

In addition to checking configuration information, ClearCase Doctor displays 
configuration information. To display all configuration information messages, click 
Options > Verbose in ClearCase Doctor.

You can run ClearCase Doctor at any time. Click Start > Programs > Rational Software> 
Rational ClearCase > Administration > ClearCase Doctor.

Modifying, Repairing, or Removing ClearCase

To modify, repair, or remove ClearCase:

1 Click Start > Settings > Control Panel.

2 Double-click Add/Remove Programs.

3 Select Rational ClearCase from the list of programs and click OK.

4 Choose one of the following options, click OK, and follow the instructions: 

❑ Modify the Existing Installation - Allows you to change which products and 
product features are installed.

❑ Repair the Existing Installation - Attempts to repair any installation that may be 
damaged or corrupted.

❑ Remove the Existing Installation - Removes all files that you previously installed 
for this product.
42 Installation Guide: Rational ClearCase



5Applying Service 
Releases
This chapter explains how to apply service releases using the Rational Download 
Manager.

Installing and Using the Rational Download Manager

To apply a Rational service release:

1 Install the Rational Download Manager client software by doing one of the 
following: 

❑ Download it from the Rational ClearCase CD. The install executable is in the 
extras folder on the CD. See the Readme.html for installation instructions.

❑ Download the service release from the Rational Download Center at 
www.rational.com/support/downloadcenter/about_dlm.jsp. You must either log in or 
register as a member before you can download the software. 

2 Install the Rational service release.

❑ Service release documentation is available at 
http://www.rational.com/docs/v2003/readme_v2003.html. The documentation 
provides service release features, restrictions, and instructions.
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AEvaluating ClearCase 
On a Local Computer
To install Rational ClearCase for evaluation, you select the Desktop install from CD 
image option.

Selecting the Desktop Installation Option

The Desktop installation from CD image option does not create a release area. It enables 
you to install the product for evaluation on a single computer, for nonproduction use.

Preparing for the Evaluation Installation

Before beginning the installation, obtain a temporary license key from Rational. 

Before you perform the evaluation installation, you must have domain administrator 
privileges to create a ClearCase server process user (clearcase_albd) and a ClearCase 
administrators group, both local to the evaluation computer.

For more information, see Logging In with Appropriate Privileges on page 27.

Performing the Evaluation Installation

This section explains how to install the ClearCase Server for evaluation and start the 
ClearCase tutorial.

Evaluating the Server and Client

To perform a server evaluation installation of ClearCase:

1 Log on with administrator privileges.

2 Insert the CD into an available drive on the host where you plan to evaluate 
ClearCase. 

3 The Welcome to the Setup Wizard page appears. Click Next to start the installation, 
and to advance through the following pages.
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4 On the Installation Type page, select Desktop installation from CD image.

5 On the Client/Server page, select Install server and client software. This option 
allows you to evaluate both server and client on one computer.

6 The Welcome to the Rational Wizard for Rational ClearCase opens. Click Next.

7 On the License Agreement page, read the license agreement. If you accept the 
terms, select I accept the terms in the license agreement. To view any third-party 
product terms, click View.

8 On the Destination Folder page, specify the directory in which to install ClearCase. 
Click Change if you want to install to another location.

Note: If the Change button is unavailable, you have other Rational products 
installed on your system. In this case, you must use the default pathname listed.

For more information about recommended product location, see Planning Your 
Installation Location on page 23.

9 On the Custom Setup page, specify how the product features are installed and 
configured:

a Select the option from the product tree on the left. You can expand or collapse 
the tree to show or hide product features.

b Click the disk drive icon to the left of the product feature name. Choose one of 
three installation options:

This feature will be installed on local hard drive - Selecting this option installs the 
selected product feature on your computer’s disk drive.

This feature, and all subfeatures, will be installed on local hard drive - Selecting 
this option installs the selected product feature, as well as all features and 
subfeatures in the product tree below the selection, on your computer’s disk 
drive.

This feature will not be available - Selecting this option does not install the 
product feature on your computer’s disk drive.

For more information about the product features, see the Help.

10 Specify your configuration settings.

The left pane of the configuration tool contains a tree structure in which to 
navigate between the various site default selection pages. Page names in the left 
pane that are marked with a red dot contain required fields that must be 
completed before the Done button is available. 

Note: Enter your temporary license key. Enter your local computer name as both 
registry and license server, when prompted.
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Advance through the pages by clicking Next. When you complete all required 
pages, click Done.

Detailed information about configuring your site defaults is available in the Help.

11 The Ready to Install the Program page appears. Click Install to begin installing the 
product. 

12 After the files have finished copying, the Installation Complete page appears. 
Click Finish. Optionally, select the appropriate check box to view the release notes 
or to go to the Rational Developer Network. 

13 Restart your computer, when prompted.

14 After you reboot and log in, the ClearCase Server Storage Wizard appears. Do one 
of the following:

❑ Use this wizard to configure storage for your evaluation copy of ClearCase. The 
Server Storage Wizard allows you to customize your storage configuration. For 
more information about the Server Storage Wizard, see Configuring Storage with 
the Server Storage Wizard on page 37.

❑ Cancel running the Server Storage Wizard and use the Getting Started Wizard, 
instead. The Getting Started Wizard automatically configures storage for your 
ClearCase installation using predetermined settings. For more information 
about the Getting Started Wizard, see Using the Getting Started Wizard on 
page 40.

The evaluation computer is now configured as a stand-alone ClearCase host. All 
accounts and services created are local to the evaluation computer.

Starting the ClearCase Tutorial

To start the ClearCase tutorial, click Start > Programs > Rational Software > Rational 
ClearCase > TutorialHelp > ClearCase Tutorial.

Completing the Evaluation

After evaluating ClearCase, if you choose to upgrade your evaluation installation to a 
licensed installation, you must request a production license, using the form at the back 
of this manual. Follow the instructions on the form and see Allocating Licenses on 
page 19.

If you choose to remove ClearCase, see Modifying, Repairing, or Removing ClearCase on 
page 42 for more information.
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BUsing Silent Install
Silent install is a method of installing Rational products on computers without 
intervention from users. It greatly reduces the work of an administrator during a 
rollout of Rational ClearCase. It also ensures that a consistent software configuration is 
installed on each target system.

To use the silent install feature, you must have the following:

■ A site defaults file (such as sitedefs.dat) that exists in a networkwide release area.

■ Target client computers on which you plan to install ClearCase.

To perform the silent install:

1 After you evaluate which Site Preparation options are necessary for the target 
ClearCase client computers, you may edit the site defaults file (or create more) by 
using the Site Preparation Tool.

2 Execute the silent install on a test target computer, monitoring the installation log 
for any unexpected results.

3 After you are confident the silent install works as you expect, prepare the target 
client computers on which to execute the silent install.

Editing the Site Defaults File with the Site Preparation 
Tool

You created a site defaults file when you created your initial networkwide release area. 
Before you create the site defaults file for silent install, you can run siteprep.exe from 
your initial release area to review the site defaults you have chosen or to make any 
modifications needed for rollout to your target client computers.

To do this:

1 Navigate to your networkwide release area and execute siteprep.exe.

2 In the Site Preparation Tool, click File > Open and navigate to the site defaults file 
that you want to review.
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3 Use the Site Preparation Tool to customize site default values for your target 
computers.

4 After you finish running the Site Preparation Tool, you are prompted to save the 
site defaults file you created with a unique name (preferably with the.dat 
extension). 

If you want to create additional versions of the site defaults file for different target 
groups of computers, you can name each version to reflect the target group name or 
function (for example, qasitedefs.dat for the Quality Assurance group). You need to 
provide the name of each site defaults file when invoking each silent install.

Executing and Monitoring the Silent Install

Now that you have customized and saved the site defaults file, you must execute 
setup.exe with a parameter that indicates you have selected the silent install feature.

Executing the Silent Install

To ensure proper results, it is very important to test every version of the site defaults 
file that you plan to use with the silent install feature before executing it on any target 
workstations.

On a test computer, in a command window, execute the silent install:

path\setup.exe /g path\sitedefs.dat

Note: You must specify the absolute or relative location of setup.exe and your site 
defaults file, unless you run setup.exe from the release area.

Monitoring the Silent Install

The silent install is designed to be transparent to users. Therefore, it is not possible to 
monitor the process by observing dialog boxes, completion bars, or other interface 
elements that appear during a conventional installation. 

Instead, you must monitor the silent install by observing the installation log output. 
Locate the installation log in your TEMP directory. To find the location, open a 
command Window and type echo %TEMP%. The location of the directory depends on 
the system environment variable TEMP you have set on your computer.

Note: To view the log (rational_install.log), you must ensure that you are displaying 
hidden system files, if you are using Windows Explorer. 
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Preparing the Target Computers

After you have tested the silent install and checked for any errors that may have 
occurred, prepare the target computers as follows:

1 Run ClearCase Doctor to verify that the proper ClearCase environment exists.

2 Execute the silent install on your target computers.

Running ClearCase Doctor to Analyze Target Computers

ClearCase Doctor tests a computer’s readiness to run ClearCase. It can identify 
configuration problems that prevent ClearCase from installing or running properly. 
You can use ClearCase Doctor to analyze your target computers before executing a 
silent install or view the results of the ClearCase Doctor analysis following silent 
installation. 

Run ClearCase Doctor by executing ccdoctor.exe from your networkwide release area. 
ccdoctor.exe resides in \release_area\Setup\program files\Rational\ClearCase\bin where 
release_area is the location of your networkwide release area.

To perform analysis on another computer on your network, from your own computer:

1 Run ClearCase Doctor.

2 Click Analysis > Select Computer.

3 Find and select the computer you want to analyze.

4 Click OK.

Executing Silent Install on Target Computers

Execute the silent install by entering the following command on the target computer:

path\setup.exe /g path\sitedefs.dat

Note: You must specify the absolute or relative location of setup.exe and your site 
defaults file, unless you run setup.exe from the release area.

Warning: It is very important that you provide the correct site defaults to the correct 
user groups. Failure to do so may result in a lengthy recovery process, such as a 
reinstallation of ClearCase.
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Performing a Silent Uninstall

You can also silently uninstall ClearCase from target computers, providing you have 
version 2003.06.00 installed.

To do this, execute this command:

msiexec.exe /X path/clearcase.msi /qn

path is the path to a file (clearcase.msi), found in your networkwide release area in the 
Setup directory, used by ClearCase during installation. /X indicates that an uninstall 
operation is executed. /qn indicates that no user interface is displayed during the 
uninstall operation.

Note: You must specify the pathname for clearcase.msi when executing this command.

To silently uninstall a previous version of ClearCase, see the documentation associated 
with that version.

For more information about msiexec.exe and associated command-line options, see the 
Microsoft Windows Installer Platform Software Developer’s Kit documentation at 
http://www.microsoft.com/windows/reskits/webresources/default.asp.
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CEnvironment-Specific 
Tasks During 
Preinstallation
Depending on what products you are planning to use in your environment, you may 
need to perform other tasks before installing a new release of Rational ClearCase.

Before performing any of the tasks in this section, see Table 12 to determine whether 
any apply to your environment.

Setting Up the IBM VisualAge for Java Integration

The ClearCase integration with IBM Visual Age for Java enables you to use ClearCase 
source control functions, such as checking out, modifying, and checking in your files, 
without leaving the Visual Age for Java IDE or starting another application. 

Before you can configure this integration with ClearCase, you must install both 
VisualAge for Java and ClearCase, in any order, and then run the VisualAge for Java 
Integration Configuration Wizard. This section describes these procedures.

Installing VisualAge for Java

To install VisualAge for Java:

1 Run the installation program for IBM VisualAge for Java Version 3.5, Enterprise 
Edition. Follow the installation instructions and prompts.

2 During the installation, select Custom. In the list of components to install, select 
External Version Control.

3 Download and install the patch for the VisualAge for Java Version 3.5, Enterprise 
Edition from http://www.ibm.com.

Running the Configuration Wizard

After both VisualAge for Java and ClearCase are installed, you must run the VisualAge 
for Java Integration Configuration Wizard. Click Start > Programs > Rational Software 
> Rational ClearCase Administration > Integrations > VisualAge for Java Integration 
Configuration.
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If ClearCase was previously installed or if the VisualAge for Java Integration 
Configuration shortcut menu does not appear in the Integrations menu:

a Click Start > Run.

b In the Run window, enter the path to the file, vaj_config.exe, in the bin folder of 
your ClearCase installation. For example, a typical path is 
C:\Program Files\Rational\ClearCase\bin\vaj_config.exe.

c Click OK.

Installation of the UCM Integration with Rational 
ClearQuest

To use the UCM integration with Rational ClearQuest, take into account the following 
issues with regard to compatibility and version support of the following elements:

■ ClearCase version (client and server)

■ ClearQuest version

■ UCM schema package

■ ClearQuest metaschema feature level

Table 15 shows the compatibility of different versions of ClearCase and ClearQuest, the 
UCM package revision number, and the ClearQuest database feature level.

Table 15 Integration of UCM with Rational ClearQuest (Part 1 of 2)

ClearCase version ClearQuest version
UCM package 
revision number

ClearQuest 
database feature 
level

4.2 2001A.04.00

2001A.04.20
2002.05.00

2.0, 3.0, 4.0 3, 5

4.2 (ClearCase only, 
not CCLT)

2003.06.00 2.0, 3.0, 4.0 3, 5

2002.05.00 2001A.04.00
2001A.04.20

2002.05.00

2.0, 3.0, 4.0 3, 5
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To upgrade to ClearCase version 2003.06.00 from an earlier version, and continue to 
use your integration of UCM with ClearQuest:

1 Upgrade ClearQuest, or upgrade both ClearQuest and the ClearCase client, 
simultaneously. 

Note: The ClearCase client upgrade is dependent on the ClearCase server upgrade.

2 Upgrade your UCM-enabled ClearQuest schema with the new version of the 
UnifiedChangeManagement Package. 

Note: To use UnifiedChangeManagement Package Revision 5.0, make sure you are 
running version 2003.06.00 of ClearCase. The UnifiedChangeManagement 
Package Revision 5.0 is dependent on AMStateTypes 1.0 and UCMPolicyScripts 
3.0 packages. 

3 Upgrade your ClearQuest user databases to use the new schema version.

2002.05.00 
(ClearCase only, not 
CCLT)

2003.06.00 2.0, 3.0, 4.0 3, 5

2003.06.00 2003.06.00 2.0, 3.0, 4.0, 5.0 3, 5

Table 15 Integration of UCM with Rational ClearQuest (Part 2 of 2)

ClearCase version ClearQuest version
UCM package 
revision number

ClearQuest 
database feature 
level
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DUpgrading from 
ClearCase LT
Rational ClearCase LT can be easily upgraded to Rational ClearCase. ClearCase 
includes a tool that helps you automate the upgrade process, though a few manual 
steps may be required for certain configurations. This section explains the upgrade 
process and two common upgrade scenarios.

Upgrade Checklist

Table 16 lists the steps required to upgrade ClearCase LT to ClearCase.

Table 16 Checklist for Upgrading ClearCase LT to ClearCase

Done Task Information

Understand changes in ClearCase 
functionality as a result of upgrading.

What Happens When You 
Upgrade? on page 58

Ensure that you have acquired upgraded 
ClearCase LT licenses for users and/or 
hosts.

Preparing to Upgrade on 
page 61

Establish your ClearCase release area. Establishing Your ClearCase 
Release Area on page 61

Check in all checked-out files or directories 
and remove all ClearCase LT views.

Remove All ClearCase LT Views 
on page 62

Perform either the simple upgrade 
procedure or the upgrade-and-merge 
procedure.

The Simple Upgrade Procedure 
on page 62 or The 
Upgrade-and-Merge Procedure 
on page 64
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What Happens When You Upgrade?

When you upgrade to ClearCase, you add many new capabilities to your ClearCase LT 
environment. Your upgraded ClearCase LT server and client hosts need little to no 
configuration. The upgrade preserves your VOB data.

Upgrade Options

When you upgrade, choose one of two options: 

■ Simple upgrade

■ Upgrade and merge

Simple Upgrade Option

In the simple upgrade procedure, you upgrade a single ClearCase LT community (one 
server and some or all of its clients) to ClearCase. Use this procedure if any of the 
following are true:

■ You are not running ClearCase at your site.

■ You are running ClearCase at your site, but do not want to add the upgraded 
ClearCase LT hosts to an existing ClearCase community.

■ You cannot upgrade all ClearCase LT client hosts at once and must preserve VOB 
access for both ClearCase LT clients and upgraded clients.

The ClearCase LT server becomes a ClearCase server and also registry host for 
upgraded clients, and continues to host all the VOBs it hosted as a ClearCase LT server. 
The ClearCase LT clients become ClearCase clients.

You can upgrade your ClearCase LT server and its clients in a single operation or 
upgrade the server first and upgrade the clients later. A ClearCase LT client can access 
an upgraded ClearCase LT server as long as it can acquire a ClearCase license from that 
server; but the client cannot use ClearCase features until it has been upgraded.

Upgrade-and-Merge Option

In the upgrade-and-merge procedure, you upgrade the ClearCase LT server and its 
clients at the same time and then make the server and clients part of an existing 
ClearCase community. Use this procedure if all of the following are true:

■ You are running ClearCase at your site.

■ You want the upgraded ClearCase LT server and clients to use the existing 
ClearCase registry.
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■ You can upgrade all ClearCase LT client hosts when you upgrade the server.

The VOBs can remain on the upgraded ClearCase LT server or can be moved to 
another ClearCase server.

Caution: Do not use the upgrade-and-merge procedure unless you can upgrade all 
ClearCase LT clients at the same time. This procedure requires you to make the 
upgraded ClearCase LT server use an existing ClearCase registry. When you do this, 
the upgraded server cannot continue as the registry server for any remaining 
ClearCase LT clients, and these clients cannot access VOBs on the upgraded server.

Upgrade Considerations

This section explains the differences in functionality when you upgrade from 
ClearCase LT to ClearCase.

ClearCase License Server and Registry Server Hosts

ClearCase requires a license server host and a registry server host. These logical servers 
may be on separate physical computers or the same computer. If you choose the simple 
upgrade, the upgraded ClearCase LT server performs both functions. If you choose the 
upgrade-and-merge option, existing ClearCase license and registry server hosts 
perform these functions.

If you choose the simple upgrade and designate your ClearCase LT server as the 
ClearCase license server and registry server host, all ClearCase LT clients, whether or 
not they have been upgraded, can access VOBs and views on the upgraded 
ClearCase LT server with minimum reconfiguration.

If you are upgrading and merging with an existing ClearCase site, you install 
ClearCase from that site’s networkwide release area and can use that release area’s site 
defaults for the license and registry server hosts. More ClearCase licenses may be 
needed after the upgrade, and you may have to add them to the license database of the 
existing license server host.

Registry Regions

ClearCase LT clients are members of a single region in a ClearCase registry that is 
maintained on the ClearCase LT server. The VOB tags and view tags in this registry 
region are unsuitable for use by ClearCase hosts. 

During a simple upgrade, the VOBs stored on the upgraded ClearCase LT server host 
are registered and tags are created for them in the server’s default ClearCase registry 
region (the region to which the server is assigned).
D - Upgrading from ClearCase LT 59



If you need to access these VOBs from client hosts that are not of the same platform 
type (UNIX or Windows) as the ClearCase LT server, you must create an additional 
registry region for use by these clients, and then create tags appropriate for the hosts 
that use this region. Step 5 of Performing the Upgrade on page 63 describes this process.

If you use the upgrade-and-merge option, you can take advantage of existing registry 
regions.

VOB Access Between Windows and UNIX

If you plan to use ClearCase with both Windows and UNIX, be aware of an 
interoperability restriction.

ClearCase hosts running UNIX cannot use dynamic views to access VOBs hosted on 
Windows. If your ClearCase LT server runs Windows and you need to access VOBs on 
UNIX using dynamic views, you must move the VOBs to a UNIX server. 

See the Administrator’s Guide for information about moving a VOB from Windows to 
UNIX.

Issues with Interoperability and Dynamic Views

ClearCase supports three kinds of views: snapshot views, dynamic views, and Web 
views.

■ Snapshot views. In a snapshot view, you load file and directory versions from a 
VOB into the platform’s native file system. Snapshot view users cannot see 
changes made by other users until they update their views. Snapshot views are 
supported by ClearCase LT.

■ Dynamic views. The ClearCase multiversion file system (MVFS) permits users of 
dynamic views to see changes made by other users as soon as the files or 
directories are checked in. ClearCase supports dynamic views on UNIX and 
Windows computers. Dynamic views are not supported by ClearCase LT.

■ Web views. Web views operate in a manner similar to snapshot views and can be 
accessed through any supported browser. 

When you use dynamic views in a homogeneous environment (views on UNIX hosts 
that access VOBs on UNIX servers or views on Windows hosts that access VOBs on 
Windows servers), the MVFS works with the native network file system (NFS on 
UNIX, LAN Manager on Windows) and needs no additional support. If your upgraded 
Windows clients use dynamic views to access VOBs or views on UNIX servers, you 
must install and configure a third-party software package to support heterogeneous 
file-system access. Two types of software provide support for this type of access. 
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To receive this support, install one of the following packages:

■ An NFS client package enables a Windows client to access a UNIX file system 
using the NFS protocol. You install NFS client software on each upgraded 
ClearCase LT client that uses dynamic views to access any VOB on a UNIX server.

■ An SMB server package enables a UNIX server to support the LAN Manager SMB 
protocol, which is native to all Windows computers. You install SMB server 
software on the upgraded ClearCase LT server.

If you plan to install such a package, install it after the upgrade is complete. For more 
information, see the Administrator’s Guide for Rational ClearCase.

Preparing to Upgrade

Before you upgrade, complete the following tasks:

■ Acquire your ClearCase licenses.

■ Establish your ClearCase release area.

■ Remove your ClearCase LT views.

Acquiring ClearCase Licenses

Before upgrading, verify that you have acquired ClearCase (and ClearCase MultiSite) 
licenses for all users. Node-locked licenses are not supported with ClearCase. 

For more information, see Allocating Licenses on page 19.

Note: ClearCase and ClearCase LT use different procedures for requesting and 
installing licenses. The Rational License Key Administrator and Rational AccountLink 
Web site cannot be used to acquire ClearCase licenses.

Establishing Your ClearCase Release Area

Before you begin, verify that you have adequate disk space on an appropriate host 
platform for a ClearCase networkwide release area. For more information, see Disk 
Space Requirements for the Release Area on page 10.

You must create a new networkwide release area with each release, except when using 
the upgrade-and-merge procedure (because you use one that already exists).
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Remove All ClearCase LT Views

All ClearCase LT views must be removed before you upgrade and re-created after the 
upgrade. Views created with ClearCase LT do not work in a ClearCase environment. 
UCM components, projects, and streams are available for use when the upgrade is 
complete, although the associated views need to be re-created.

Note: If your ClearCase LT server is running UNIX and you plan to use the simple 
upgrade procedure to upgrade the server and some, but not all, ClearCase LT clients, 
you can leave your ClearCase LT views in place until all the clients have been 
upgraded.

To remove your ClearCase LT views:

1 If you are using UCM, complete any deliveries that are in progress.

2 Verify that there are no remaining checkouts; use the ClearCase Explorer or the 
cleartool lscheckout command.

3 Remove all views. To do so, use the ClearCase Explorer on any Windows platform 
or use the cleartool rmview command on either Windows or UNIX.

The Simple Upgrade Procedure

In this procedure, you must upgrade the server first, and then upgrade some or all of 
the clients. Many steps in this procedure are also required in the upgrade and merge 
procedure.

If You Cannot Upgrade All Your Clients at the Same Time

If you have chosen to do a simple upgrade, you can defer upgrading some of your 
ClearCase LT client hosts for a few days or weeks to accommodate development 
schedules or other organizational requirements. ClearCase LT client hosts can access 
VOBs on the upgraded ClearCase LT server as long as the server is configured as a 
ClearCase license server host. 

The remaining ClearCase LT client hosts must acquire ClearCase licenses to access 
VOBs on the upgraded server, which is possible only if the server itself has been 
configured as a ClearCase license server host. These clients cannot be configured to 
acquire ClearCase licenses from another ClearCase license server host, even if one is 
present in your environment. ClearCase LT clients that operate in this transitional 
mode are still limited to using the ClearCase LT feature set even though they require a 
ClearCase license.
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Performing the Upgrade

To perform a simple upgrade:

1 Prepare. Complete the applicable upgrade prerequisites described in Preparing to 
Upgrade on page 61.

2 If you are running ClearCase LT version 2002.05.20 and earlier, remove 
ClearCase LT software from the ClearCase LT server. Follow the instructions in 
the Installation Guide for Rational Server Products. Do not remove ClearCase LT 
data unless you are sure you do not need it after the upgrade. The upgrade 
procedure preserves all ClearCase LT data and makes it available to ClearCase 
after the upgrade is complete.

3 Install ClearCase on the ClearCase LT server. Follow all instructions in Chapter 3, 
Creating a Release Area.

When you configure your site defaults, you are prompted to create server storage 
locations for VOBs and views. The remainder of the upgrade process converts 
existing VOB server storage locations on the upgraded ClearCase LT server, so you 
only need to create view storage locations at this time. You may also create 
additional VOB storage locations.

Install ClearCase in the same directory where ClearCase LT is installed. If 
necessary, change the default installation directory.

For information about view and VOB storage locations, see the Administrator’s 
Guide.

4 Run the upgrade tool. You must next run the cclt2cc upgrade tool. The upgrade 
tool performs these tasks:

❑ Registers VOB storage locations on the upgraded ClearCase LT server in the 
server’s default registry region.

❑ Creates VOB tags for VOBs on the upgraded ClearCase LT server in the server’s 
default registry region.

❑ Changes file system protection information about all VOB storage directories so 
that it is appropriate for ClearCase.

Note: If the installation process detects that a ClearCase LT server resides on the 
system, you must uninstall ClearCase LT and start the installation again. 

cclt2cc is located in the ccase-home-dir\etc\utils directory. To run cclt2cc:

a Log in as a user with local administrator privilege to the upgraded 
ClearCase LT server.

b Set the registry password. For instructions, see the Administrator’s Guide.
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c Run the command at the Windows command prompt. The example below 
upgrades all the VOBs on the ClearCase LT server and creates tags for them in 
the server’s default region

ccase-home-dir\etc\utils\cclt2cc -w registry-password

For more information about the cclt2cc tool and associated command-line options, 
see cclt2cc Command Line Options on page 67.

5 Create an additional ClearCase registry region if needed. If you require 
interoperability between Windows and UNIX hosts:

a Create a new region for UNIX hosts.

b On Windows hosts, specify this region as a peer region.

For information about creating peer regions and other associated tasks, see the 
Administrator’s Guide.

6 Install ClearCase on ClearCase LT clients. Follow the instructions in Chapter 4, 
Installing from a Release Area. Accept the default choices for registry region and 
license server host

7 Create new snapshot and/or dynamic views. Use the ClearCase Explorer or the 
mkview command. For information about reusing UCM streams, see Creating New 
UCM Views That Use Existing Streams on page 66.

The Upgrade-and-Merge Procedure

Using the Upgrade-and-Merge option, you upgrade ClearCase LT server and its clients 
to ClearCase, and then incorporate the ClearCase LT VOBs and upgraded hosts into an 
existing ClearCase community. 

Caution: Do not use the upgrade-and-merge procedure unless you can upgrade all 
ClearCase LT clients at the same time. Upgrade and merge requires you to make the 
upgraded ClearCase LT server use an existing ClearCase registry. When you do this, 
the upgraded server cannot continue as the registry server for any remaining 
ClearCase LT clients, and these clients cannot access VOBs on the upgraded server.

Performing the Upgrade and Merge

To upgrade and merge your ClearCase LT community:

1 Prepare. Complete the applicable upgrade prerequisites, as described in Preparing 
to Upgrade on page 61. Verify that all ClearCase LT clients are ready to be 
upgraded. After you complete Step 2 in this procedure, no ClearCase LT client can 
access VOBs or views on the ClearCase LT server.
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2 If you are running ClearCase LT version 2002.05.20 or earlier, remove 
ClearCase LT software from the ClearCase LT server. Follow the instructions in 
the Installation Guide for Rational Server Products. Do not remove ClearCase LT 
data unless you are certain that you do not need it after the upgrade. The upgrade 
procedure preserves all ClearCase LT data and makes it available to ClearCase 
after the upgrade is complete.

3 Install additional ClearCase licenses on the license server host if needed. Users 
who run ClearCase commands on upgraded ClearCase LT hosts can use licenses 
from the existing license pool. If you already have an adequate number of these 
licenses, you do not need to install additional licenses.

4 Install ClearCase on the ClearCase LT server. Follow all instructions in Chapter 3, 
Creating a Release Area. Accept the predefined site default values.

Note: When you upgrade the ClearCase LT server, you must install ClearCase in 
the directory where ClearCase LT was installed (normally 
C:\Program Files\Rational\ClearCase). Otherwise, the upgrade procedure cannot 
complete successfully. This restriction does not apply when upgrading 
ClearCase LT clients.

5 Run the upgrade tool. You must next run the cclt2cc upgrade tool. The upgrade 
tool performs these tasks:

❑ Registers VOB storage locations on the upgraded ClearCase LT server in the 
server’s default registry region.

❑ Creates VOB tags for VOBs on the upgraded ClearCase LT server in the server’s 
default registry region.

❑ Changes file system protection information about all VOB storage directories so 
that it is appropriate for ClearCase.

Note: If the installation process detects that a ClearCase LT server resides on the 
system, you must uninstall ClearCase LT and start the installation again. 

cclt2cc is located in the ccase-home-dir\etc\utils directory. To run cclt2cc:

a Log in as a user with local administrator privilege to the upgraded 
ClearCase LT server.

b Run the command at the Windows command prompt. The example below 
upgrades all the VOBs on the ClearCase LT server and creates tags for them in 
the server’s default region

ccase-home-dir\etc\utils\cclt2cc -w registry-password

For more information about the cclt2cc tool and associated command-line options, 
see cclt2cc Command Line Options on page 67.
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6 Get information about storage locations and VOBs on the upgraded server. Log 
on to the upgraded ClearCase LT server. Run the cleartool lsstgloc –l and lsvob –l 
commands to get information about server storage locations and VOBs on the 
upgraded server. You need this information in Step 7 and Step 8 of this procedure.

7 Register the upgraded server’s storage locations in the existing registry. On 
another ClearCase host—one that has network access to the file system of the 
upgraded ClearCase LT server and is a member of the registry in which you want 
VOBs on the upgraded ClearCase LT server to have tags—run the cleartool 
mkstgloc command to register storage locations on the upgraded ClearCase LT 
server.

8 Register and create tags for the upgraded server’s VOBs in the existing registry. 
On the same ClearCase host that you used in Step 7, run the cleartool register and 
mktag commands to register and check tags for the VOBs on the upgraded 
ClearCase LT server.

9 Verify that the VOBs are accessible. Verify that all ClearCase hosts in the region 
can access the VOBs on the upgraded ClearCase LT server.

10 Make the upgraded server a member of the existing registry. Reconfigure the 
upgraded ClearCase LT server so that it is no longer a registry server and is 
instead a member of the existing registry region.

11 Create an additional ClearCase registry region if needed. If you require 
interoperability between Windows and UNIX hosts:

a Create a new region for UNIX hosts.

b On Windows hosts, specify this region as a peer region.

For more information about these tasks, see the Administrator’s Guide.

12 Install ClearCase on ClearCase LT clients. Follow the instructions in Chapter 4, 
Installing from a Release Area. Accept the default choices for registry region and 
license server host.

13 Create new snapshot and/or dynamic views as needed for the upgraded clients. 
Use the ClearCase Explorer or the mkview command. For information about 
reusing UCM streams, see Creating New UCM Views That Use Existing Streams on 
page 66.

Creating New UCM Views That Use Existing Streams

The upgrade process preserves all of a UCM project’s streams. If your upgrade takes 
place while a project is active, you may want to create new views using the project’s 
existing streams. You can use either the Project Explorer or the Join Project Wizard to 
do so:
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In the Project Explorer:

1 Select the stream you want to use.

2 Click File > New > View.

In the Join Project Wizard:

1 Select the project you want to join.

2 In Step 2 (Create a Development Stream), click Advanced Options.

On the Stream tab, click Reuse an existing development stream, and then select the 
stream you want to reuse.

cclt2cc Command Line Options

This section summarizes the command line options for the cclt2cc upgrade tool.

SYNOPSIS

cclt2cc –w tag-registry-password [–v vob-tag-list] [–d destination-region] 
[–p vob-tag-prefix]

OPTIONS AND ARGUMENTS

Tag Registry Password

Default
None.

–w tag-registry-password
The registry password for the tag registry in which new VOB tags will be 
created.

VOBs to Upgrade

Default
Upgrade all VOBs.

–v vob-tag-list
Upgrade only the VOBs in vob-tag-list, a comma-separated list of VOB tags.
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Destination Region

Default
The server’s default region.

–d destination-region
Create VOB tags in destination-region instead of the default.

VOB Tag Prefix

Default
vobs

–p vob-tag-prefix
Create UNIX VOB tags with a prefix of vob-tag-prefix instead of the default. 
This option is ignored if specified on Windows NT.
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Licensing Forms
for the

ClearCase Product Family 





The ClearCase family of products includes a license enforcement mechanism. As described in the
product’s installation documentation, you must obtain a license authorization code, an encoded line of
text to be inserted into a special license database file. Please fill in the following form completely. Upon
completing the form, FAX it to Rational Software Corporation at (781) 676-2460. You will receive your
authorization code via return FAX as soon as possible.

Product to License (check one): 
_____ ClearCase _____ MultiSite

Your Company 
1. Company name____________________________________________________________________
2. Address __________________________________________________________________________
3. City/State/Country/Postal Code ____________________________________________________
4. Contact Person ____________________________________________________________________
5. Phone number (with area code): _____________________________________________________
6. FAX number (with area code): _______________________________________________________
7. Electronic mail address of contact person: _____________________________________________

Licensing Information 
8. Purchase Order Number (For new licenses purchased): _________________________________
9. License server host ID:______________________________________________________________

If ClearCase is installed, enter clearlicense –hostid on the license server. If not: 
Solaris: run /usr/sbin/sysdef –h to determine 8-digit hex number
HP-UX: run /bin/uname –i to determine number (usually, 10 or 12 digits)
AIX: run /bin/uname –m to determine 12-digit number
Linux: run hostid 
Windows: on the command line, cd to the directory SETUP\program 

files\Rational\SETUP\hostid on the ClearCase CD-ROM and run 
hostid.exe

10. New licenses requested or additional licenses required:
Number of licenses: _______

(Do not include licenses already installed. For additional licenses, add new License Authorization
Code to the .db file.)

Please FAX — do not phone and do not use electronic mail 

ClearCase Product Family License Registration Form 





Please complete and sign the following form. Upon completion, FAX to Rational Software Corporation
at (781) 676-2460.

I certify that Rational’s ClearCase software, under the terms of the signed Software License
Agreement, will be deleted in its entirety from the old host referenced below, and will be installed on
one or more new hosts.

Authorized Signature: ___________________________________________________

Move Licenses (check one): 
_____ ClearCase _____ MultiSite

Your Company 
1. Company name____________________________________________________________________
2. Address __________________________________________________________________________
3. City/State/Country/Postal Code ____________________________________________________
4. Contact Person ____________________________________________________________________
5. Phone number (with area code): _____________________________________________________
6. FAX number (with area code): _______________________________________________________
7. Electronic mail address of contact person: _____________________________________________

Licensing Information 
8. Host ID of old license server:_________________________________________ # of licenses _____

Host ID of new license server #1: _____________________________________ # of licenses _____
Host ID of new license server #2: _____________________________________ # of licenses _____

If ClearCase is installed, enter clearlicense –hostid on the license server. If not: 
Solaris: run /usr/sbin/sysdef –h to determine 8-digit hex number
HP-UX: run /bin/uname –i to determine number (usually, 10 or 12 digits)
AIX: run /bin/uname –m to determine 12-digit number
Linux: run hostid 
Windows: on the command line, cd to the directory SETUP\program 

files\Rational\SETUP\hostid on the ClearCase CD-ROM and run 
hostid.exe 

Please FAX — do not phone and do not use electronic mail 

Request to MOVE ClearCase Product Family Licenses 
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